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Verif. Conexiones 

(Timbrado) 

Idea del Programa 

Declaración de  

Especificaciones 

Diagrama de Bloques 

Pinout y Esquemático 

de la Placa 

Desarrollo de un 

Prototipo 

Verif. Funcional 

Desarrollo Placa C.I. 
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CICLO DE DESARROLLO SOFTWARE 
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Verif. Sintaxis 

(Compilador) 

Idea del Programa 

Declaración de  

Especificaciones 

Estructura y Diseño 

Escritura de los 

Programas 

Generación 

(Linker) 

Simulación en PC 

Depuración en Micro 

Grabación del Micro 
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ENTORNO DE TRABAJO: 

DIAGRAMAS DE FLUJO  
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DIAGRAMAS DE FLUJO 

 Son representaciones del funcionamiento de un programa 
 De forma genérica – independiente de la arquitectura 

Nunca pueden contener referencias a registros de la 
arquitectura utilizada, ni a instrucciones de la CPU 

 Que muestran la solución al problema planteado 

 Que tienen que servir de guía, tanto al programador como a 
los posibles programadores que tengan que tocar ese 
programa 

 Se pueden escribir a distintos niveles de 
detalle/abstracción 
 El nivel de detalle que debe ser utilizado dependerá de la 

situación 

 Tradicionalmente se utilizarán sólo los símbolos sencillos: 
 Elipse o círculo, para indicar una etiqueta 

 Rectángulo, para indicar un proceso 

 Rombo, para indicar una decisión 
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Programa que espera 2 segundos para encender un LED en la salida digital PA1 

del micro y luego la deja encendida para siempre  

¿Contador = 2 sg? 

Enciendo 

la salida 1 

SI 

NO 

Inicializo 

registros 

necesarios, 

el contador 

y apago el 

LED 

DIAGRAMAS DE FLUJO: EJEMPLO 

Inicio de 

programa 

Fin de 

programa 
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ENTORNO DE TRABAJO: LA PLACA 

DE DESARROLLO STM32L-

DISCOVERY 
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STM32L-DISCOVERY 
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STM32L-DISCOVERY 

 La placa de desarrollo tiene las siguientes 
funcionalidades: 

 Microcontrolador STM32L152RB 

 Interfaz de depuración ST-LINK/V2 incluido 
(conectado al ordenador a través de Mini-
USB) 

 Una pantalla LCD de 24 segmentos y 4 
comunes 

 4 LEDs 

 2 de ellos programables por el usuario 
(LED_VERDE, LED AZUL) 

 Un sensor táctil lineal, con posibilidad de ser 
utilizado como 4 teclas individuales 

 Botón programable por el usuario (USER) 

 2 Puertos de expansión a placa adicional (P1 
y P2) 
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D. DE BLOQUES Y LAYOUT 
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D. DE BLOQUES Y LAYOUT 
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PB6 

PB7 

PA0 

Alimentación a través del USB 

PUERTO P1: 

 

04 – PC13 

15 – PA0 

 ADC_IN0 

 TIM2_CH1_ETR 

19 – PA4 

 ADC_IN4 

 DAC_OUT1 

20 – PA5 

 SPI1_SCK 

 ADC_IN5 

 DAC_OUT2 

 TIM2_CH1_ETR 

PUERTO P2: 

 

07 – PB7 

 I2C1_SDA 

 TIM4_CH2 

 USART1_RX  

08 – PB6 

 I2C1_SCL 

 TIM4_CH1 

 USART1_TX 

12 – PD2 

 TIM3_ETR 

13 – PC12 

19 – PA12 

 USBDP 

 SPI1_MOSI 

20 – PA11 

 USBDM 

 SPI1_MISO 
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STM32L-DISCOVERY 

 Display LCD de 6 

caracteres con 2 

formatos de 

visualización 

seleccionables: 

 caracteres de 8 o 

 caracteres de 14 

segmentos 

 Escala de barras en 

la parte derecha. 
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PRÉSTAMO DE LA PLACA DE DESARROLLO 

 Durante el curso, se va a permitir el préstamo 
personal de: 

 La Placa de Desarrollo STM32L-Discovery 

 El préstamo se hace con la condición de que el 
material se devuelva antes del examen en perfecto 
estado 

 De no ser así, el alumno no será evaluado en la 
asignatura 

 Para obtener el material: 

 Imprimir, rellenar y firmar TRES copias del 
formulario de préstamo del material. El formulario se 
encuentra en Aula Global. 

 Entregar al coordinador de la asignatura el 
formulario, para que lo firme y se quede con una copia. 

 Acercarse al despacho 1.1.I.04 o 1.1.I.03 para entregar 
la autorización firmada por el profesor, y recoger el 
material. 

 El material se devolverá en los mismos despachos, 
entregándolo con el formulario de devolución 
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ENTORNO DE TRABAJO: KEIL 

UVISION 5 
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CONCEPTOS FUNDAMENTALES 

 El entorno de desarrolla se basa en el concepto de 

proyecto, en el que se incluyen los ficheros (.s y .c) y 

bibliotecas a compilar, para obtener el programa definitivo 

 El programa se puede descargar directamente en la placa 

de desarrollo a través de la opción de Debug. 

 La depuración se puede hacer paso a paso, consultar 

variables, registros, etc. 

 Para simplificar el uso del sistema, especialmente en las 

primeras prácticas, se ha creado una biblioteca 

(Biblioteca_SDM.lib) que facilita: 

 La configuración del reloj del sistema (SYSCLOCK) y sus 

derivados. 

 La inicialización del LCD y sus pines. 

 El uso del LCD. 
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INSTALACIÓN DE KEIL UVISION 5 
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INSTALACIÓN 
 El programa de instalación se puede descargar: 

 Directamente de la página de Keil (https://www.keil.com/arm/demo/eval/arm.htm) 
rellenando el formulario y descargando en MDK 

 Desde Aula Global , donde se encuentra el programa comprimido en 4 ficheros .rar, que 
una vez descomprimidos, generan un fichero .exe que es el programa de instalación. 

 Ejecutando el mdk522.exe (o equivalente, ya que los números pueden cambiar, al 
cambiar la versión) se arranca el instalador del µVision : 
 Es preferible instalar el programa con la placa ya conectada, para que así se instale el 

driver de la placa 
 Si no se hace así, se puede instalar posteriormente el driver 

 De a todas las pantallas sobre Next, introduciendo la información solicitada 
 Si no sabe que poner en alguna opción, déjela en su valor por defecto. 

 Al finalizar la instalación del µVision, se solicitará la instalación de los drivers tipo 
ULINK, ST-Link, etc. 
 Aceptar todo el proceso 

 En algunos ordenadores o cuando se haya instalado el µVision sin tener la placa 
conectada, hay que instalar a mano el driver. Para ello: 
 Vaya a la página http://www.st.com/internet/evalboard/product/251168.jsp y pulse en la 

pestaña “Design Support”. 

 Seleccione para descargar el “ST-LINK/V2 USB driver for Windows 7, Vista and XP” 

 Descárguelo (también se puede hacer esta escarga desde Aula Global), descomprímalo y 
ejecútelo aceptando todas las opciones (incluso las preguntas de seguridad que impone el 
Windows) 

 Si sigue dando problemas, desenchufe el cable USB, espere unos segundos, y vuelva a 
enchufarlo.  
 Pruebe en distintos puertos USB 

 Si tenía una instalación anterior que no funcionaba, tendrá que ir, con la placa conectada, al 
Administrador de Dispositivos, y borrar el controlador que da fallos (el que salga con un símbolo de 
exclamación). 
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INSTALACIÓN DE KEIL UVISION 5 

 Ejecute el programa mdk522.exe (o la versión actual 

existente) 
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INSTALACIÓN DE KEIL UVISION 5 

 Acepte las condiciones de la licencia 
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INSTALACIÓN DE KEIL UVISION 5 

 Seleccione el lugar para la instalación, o acepte la 

ubicación por defecto 
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INSTALACIÓN DE KEIL UVISION 5 

 Introduzca sus datos 
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INSTALACIÓN DE KEIL UVISION 5 

 Espere a que se instale la aplicación 
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INSTALACIÓN DE KEIL UVISION 5 

 Una vez finalizada la instalación le puede solicitar ver las 

Release Notes y usar (o no) la configuración anterior (si 

tenía ya una versión anterior instalada. 
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INSTALACIÓN DE KEIL UVISION 5 

 Una vez instalado el uVision, se le solicitará que instale los 

paquetes necesarios 

 uVision es una plataforma de desarrollo que contempla multitud de 

procesadores, por lo que instalar todo puede ser excesivo. 
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INSTALACIÓN DE KEIL UVISION 5 

 Localice (en la pestaña Devices) la familia de 

STMicroelectronics 
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INSTALACIÓN DE KEIL UVISION 5 

 Navegue por el árbol de dispositivos hasta encontrar el STM32L1 
Series 

 Seleccione esa opción y pulse “Install” o “Update” en cada uno de los 
botones que aparecen en la ventana de la derecha 

 Esto hará que se conecte a internet para bajarse las últimas versiones 
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INSTALACIÓN DE KEIL UVISION 5 

 Durante la instalación de los paquetes, le pedirá que 

acepte algunas licencias de uso. 
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INSTALACIÓN DE KEIL UVISION 5 

 Una vez instalados todos los paquetes, la apariencia debe ser 
como la de la figura. 

 En este momento puede cerrar el instalador de paquetes y ya 
puede utilizar el uVision 5, como si fuese cualquier otro 
programa de Windows. 
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PASOS PARA LA CREACIÓN DE UN 

PROYECTO EN UVISION 5 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Al arrancar el Keil uVision 5, asegurarse que no hay 

ningún Proyecto abierto, utilizando la opción 

Project►Close Project 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Para crear un proyecto utilizar la opción Project►New 

uVision Project 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Después de seleccionar la carpeta donde va a ubicar todos los 

ficheros del proyecto, de un nombre significativo al proyecto 

 Se recomienda que para cada programa cree un proyecto distinto, y 

que para cada proyecto, cree una carpeta distinta 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 En la siguiente pantalla tiene que seleccionar el 
microcontrolador con el que va a trabajar 

 Seleccione la carpeta STMicroelectronics 

 Seleccione el microcontrolador STM32L152RB 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 En la siguiente pantalla es necesario seleccionar los elementos 
relacionados con el microcontrolador (y la placa de desarrollo) 
que se han de integrar al proyecto. Para ello seleccione: 
 Device ► Startup 

 CMSIS ► CORE 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Una vez finalizada toda esta fase, aparece el proyecto creado con 
algunos elementos integrados (CMSIS y Device) y una carpeta 
denominada SourceGroup1 en la que introduciremos los archivos 
fuentes del proyecto 
 Esto se comentará más adelante, porque todavía faltan pasos 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Hay que configurar el entorno de desarrollo, y en concreto 
el Depurador y la herramienta para cargar la aplicación 

 Pulse en el botón derecho en Target y selecciones Options 
for Target … 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Seleccione la pestaña Debug y seleccione la opción de utilizar un 
depurador (la columna de la derecha) y dentro de las opciones de 
depuradores, seleccione el ST-Link Debugger 

 Fíjese en las casillas que están activadas en la figura, puesto que es la 
configuración recomendada. 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Después de seleccionar el depurador (ST-Link Debugger), pulse el botón de Settings, para ver 
la configuración del mismo 

 Seleccione como puerto SW. 

 Si tiene conectada la placa, entonces verá a la derecha los datos de la placa conectada (ver 
figura). Si no, verá una pantalla como la de la figura de la transparencia siguiente. 

 En cualquier caso, fíjese en las casillas seleccionadas y use esa configuración 
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PASOS EN LA CREACIÓN DE UN PROYECTO 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Después de aceptar las opciones del depurador, seleccione 

la pestaña de Utilities y copie la configuración que se 

muestra en la pantalla 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Pulse en el botón de Settings (dentro de Utilities) y verifique 
que tiene un mapa de memoria instalado (por ejemplo el 
expuesto en la figura) 

 También se recomienda que se seleccione “Erase Full Chip” 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Una vez aceptados los cambios en la configuración del Target, el proyecto está 
listo para poder darle contenido, creando e importando nuevos ficheros fuente. 

 Empezamos creando un fichero fuente, para lo que seleccionamos File ► New… 

 Esto creará una sub-ventana en la parte gris de la derecha, para poder teclear el 
código 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Una vez escrito el código (en el que no está resaltada la 

sintaxis por no saber el entorno que tipo de fichero es), 

hay que guardar el fichero con la opción File ► Save 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Póngale un nombre con la extensión adecuada al formato (por ejemplo, si es un fichero en C, 
póngale un nombre acabado con .c; si es un fichero “header” de C, póngale un nombre acabado 
con .h) 

 Al almacenarlo con un nombre y extensión, ya será posible que el entorno resalte la sintaxis 
con colores. 

 El nombre del fichero puede ser cualquiera, pero se aconseja que sea un nombre 
representativo 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Sin embargo, todavía no está ese fichero en el proyecto, por lo que 
habrá que decirle al proyecto la necesidad de incorporarlo al mismo. 

 Para ello pulse el botón derecho en SourceGroup1 y seleccione Add 
Existing Files to Group “SourceGroup1” … 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Se puede ver el fichero integrado ahora en el proyecto, pero sin embargo 
se notifican errores. Eso es porque faltan todavía ficheros por integrar 

 Se aconseja que copie en la misma carpeta donde está el proyecto los 
ficheros .h que se vayan a importar, así como cualquier otro fichero que se 
haya de integrar en el proyecto (archivos .c, archivos .lib, etc.) 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 De la misma forma que hizo con el fichero .c inicial, inserte en el proyecto (dentro de SourceGroup1) el resto 
de ficheros compilables y linkables necesarios 
 Ficheros .c y ficheros .lib 

 NO inserte los ficheros .h, puesto que éstos se integrarán solos al compilar el proyecto. 

 En el ejemplo, el proyecto queda como en la figura, habiendo integrado la biblioteca suministrada 
(Biblioteca_SDM.lib) y una biblioteca adicional creada por los profesores (que no se distribuye) denominada 
Utiles_SDM.c (en un futuro se le aconsejará a los alumnos que creen su propia biblioteca de utilidades) 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 El proyecto ya está listo para compilar 

 Seleccione Project ► Rebuild all target files 
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PASOS EN LA CREACIÓN DE UN PROYECTO 

 Durante la compilación verá aparecer mensajes en la ventana inferior 
del programa, y finalmente un mensaje diciendo el número de errores 
y avisos (warnings) resultantes. 

 Una vez conseguido 0 errores, está listo para ejecutar el proyecto 
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PASOS EN LA DEPURACIÓN DE UN 

PROYECTO 
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PASOS EN LA DEPURACIÓN DE UN PROYECTO 
 Una vez compilado correctamente, conecte la placa al USB y ejecute el depurador 

con el botón: 
 Tardará bastante hasta que cargue y luego aparecerá un aviso del modo de evaluación. 

Pulse Aceptar. 

 Si se abre una ventana con ensamblador, pulse       para cerrarla. 

 Como puede ver, el programa se ha ejecutado hasta llegar a la función main(). La 
flecha amarilla indica el punto del programa donde se encuentra la ejecución 
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PASOS EN LA DEPURACIÓN DE UN PROYECTO (1) 

 Para depurar, se pueden utilizar las siguientes opciones: 

 1) Ejecutar de corrido todo el programa desde el punto actual. 
Si hay puntos de ruptura, se para en ese punto 

 2) Se depura la función actual, pero sin entrar en ella 

 3) Se ejecuta todo el programa hasta el punto donde 
actualmente se encuentra el cursor 

 4) Se depura la función actual, entrando en ella, si es necesario 

 5) Se sale de la función actual (se ejecuta lo que queda de 
función y se pausa la ejecución al finalizarla). Solo funciona 
cuando se ha activado la anterior previamente 

 Además, puede poner un punto de ruptura (breakpoint, es 
decir, pausa la ejecución cuando llega a ese punto) 
haciendo doble clic en cualquier punto a la izquierda del 
número de línea. 

 Aparecerá un círculo en rojo. 

 Si se vuelve a hacer doble clic, se quita el breakpoint. 
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PASOS EN LA DEPURACIÓN DE UN PROYECTO (2) 

 Para examinar el valor de una variable, abra una Watch 
Window (View►Watch Windows►Watch 1) 

 En la parte inferior derecha, junto con Call Stack y con Memory 1 se 
abre una nueva pestaña denominada Watch 1 

 En dicha pestaña, escriba el nombre de la variable, registro o conjunto 
de registros. 

 Por ejemplo, escriba RCC y verá una estructura completa con los registros 
del reloj 

 En cada variable se puede ver su valor (sólo si se entra en la función 
donde se ejecuta) o incluso modificarlo para que sea tenido en cuenta 
en el siguiente paso de ejecución. 

 Para ver los registros asociados a los periféricos o modificar su 
valor, seleccione la opción “Peripherals ►System Viewer” y 
ahora haga visible el registro deseado (por ejemplo: GPIO -> 
GPIOB) 

 Por ejemplo, active el LED verde y rojo en PB6 y PB7, activando los 
bits BS6 y BS7 del registro BSRR en GPIOB o desactívelos activando 
los bits BR6 y BR7 de dicho registro (cuando el depurador esté dentro 
de la funcion WHILE(1)  
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PASOS EN LA DEPURACIÓN DE UN PROYECTO (3) 
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EJERCICIOS 
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PROYECTO EJEMPLO PARA PROBAR EL LCD DE LA PLACA 
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/** Ejemplo de uso del LCD  **/ 

 

#include "Biblioteca_SDM.h“ 

 

int main(void){ 

   Init_SDM(); 

   Init_LCD(); 

     

   while (1) { 

      LCD_Limpia(); 

      LCD_PreparaBarras(OFF, OFF, OFF, ON); 

      LCD_Texto("UNO"); 

 

      LCD_Limpia(); 

      LCD_PreparaBarras(OFF, OFF, ON, ON); 

      LCD_Texto("DOS"); 

 

      LCD_Limpia(); 

      LCD_PreparaBarras(OFF, ON, ON, ON); 

      LCD_Texto("TRES"); 

 

      LCD_Limpia(); 

      LCD_PreparaBarras(ON, ON, ON, ON); 

      LCD_Texto("MAAMBO"); 

       

      } 

   }   
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PRUEBA DEL PROYECTO EXPLICADO  
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EJERCICIOS 

 1) Cree el proyecto ejemplo y depúrelo. 

 2) Ejecútelo de forma seguida. ¿Ve algo en el display si lo 

ejecuta de forma seguida?. 

 3) Entre mensaje y mensaje en el LCD introduzca una 

espera de 1 segundo para poder ver algo, utilizando para 
ello un bucle for(intente ajustar en número de ciclos del 

bucle for para que cada espera sea de 1 segundo). Para 

ello, tenga en cuenta: 
 Que cada instrucción en ensamblador se ejecuta en un único ciclo de 

reloj. 

 Que cada instrucción en C son varias instrucciones en ensamblador. 

 Que el reloj está funcionando a 32MHz. 

 4) Cambie el programa para que la función for creada esté 

dentro de una librería llamada “utiles.h” y sea más 

elegante. 
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